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As Chair of the Family Law Section 
of The Florida Bar for 2018-2019, I 
am very excited to kick off this New 
Bar Year by letting you know what 
has been happening and what’s in 
store for the Section this year!

As many of you know, we had a very 
productive and exciting year under 
Nicole Goetz’s noteworthy leadership. 
At our Annual Luncheon held during 
The Florida Bar Annual Convention 
in June, Nicole recognized those indi-
viduals who really helped make her 
year great. Just to hit a few of the 
highlights:

Nicole Goetz honored the following 
members for their “Above and Beyond 
Service,” for exceeding all expecta-
tions with their tireless dedication 
and hard work to benefit the Section 
in 2017-18: Aimee Gross, Diane M. 
Kirigin, Carin Porras and Bonnie 
Sockel-Stone.

In each year, the Chair acknowl-
edges a few “Rising Stars” for recog-
nition of their enthusiasm, initiative 
and outstanding service to the Family 
Law Section and its goals. This year, 
Nicole selected Trisha Armstrong, 
Stephanie Matalon, Ryan Tarnow 
and Anya Cintron Stern.

The following members and officers 
of the Section were also awarded for 
their invaluable contributions and 
time spent protecting Florida’s Fami-
lies during the 2018 Legislative Ses-
sion: John Foster, Aimee Gross, Amy 
Hickman, Kristin Kirkner, Kristi 
Beth Luna, Bonnie Sockel-Stone, Da-
vid Manz, Shannon Novey, Michelle 
Klinger Smith and Phil Wartenberg.

Our Section was lucky enough to 
have the support of Senator Kathleen 
Passidomo and Representative Dan-
iel Perez to ensure that the Section’s 
Equitable Distribution bill success-
fully became law in 2018.

Also, the Underage Marriage bill 
was fully backed and supported by 
Representatives Jeanette Nunez and 

Frank White along with Senator Liz-
beth Benacquisto. Thank you all for 
your unwavering support of the Fam-
ily Law Section’s mission and goal in 
ensuring the laws of our state and 
Florida’s families are best served and 
legally protected. Thank you to our 
wonderful team at Southern Strate-
gies—Nelson Diaz, Edgar Castro and 
Kevin Cabrera—for your hard work, 
dedication and assistance in this leg-
islative session.

The Chair’s Award of Extraordi-
nary Service was given to the Sec-
tion’s very own, well-deserving mem-
ber Sarah E. Kay. The Chair’s Award 
of Special Merit was given to Sheena 
Benjamin-Wise, Ronald Bornstein, 
Belinda Lazzara, Matthew Lundy, 
Michelle Klinger Smith, Phil Wart-
enberg and C. Deb Welch.

Nicole recognized Sarah R. Sullivan 
with The Alberto Romero “Making 
a Difference” Award at the annual 
luncheon for her tireless efforts for 
the benefit of the Section and The 
Florida Bar.

The Honorable Raymond T. McNeal 
Professionalism Award was given to 
Past Section Chair Maria C. Gonza-
lez for her never-ending, forever and 

absolute professionalism in all walks 
of her life, including personally and 
professionally.

Spotlight Awards were given to 
the following Section members for 
their positive impact and outstand-
ing service to the Section: Heather 
Apicella, John Foster, Tenesia Hall, 
David Hirschberg, Ronald Kauffman, 
Christopher Rumbold, Robin Scher 
and Eddie Stephens, III.

Nicole recognized Lisa Tipton, our 
Communications Consultant, and 
Gabrielle Tollok, our Section Admin-
istrator, for their tireless support and 
continued efforts to assist our Section 
in accomplishing all of our goals.

Under Nicole’s lead, our very own 
“Bounds of Advocacy” were re-written 
to bring them more current with our 
ever-changing world. Championing 
this effort, our Section was lucky to 
have Co-chairs Richard West, Past 
Chair, and Melinda Gamot; along 
with their Ad Hoc Committee includ-
ing: the Honorable Scott Bernstein; 
Dr. Deborah Day; Maria C. Gonzalez; 
Ky Koch, Past Chair; David Manz, 
Past Chair; the Honorable Raymond 
McNeal; and Ashley Myers. The com-
mittee was tasked with and accom-
plished this goal seamlessly. The ac-
tual print version was mailed to all 
members just after the convention 
and should have been received as of 
the writing of this message.

We also elected and welcomed the 
new Executive Committee members, 
as Chair, myself, Chair-Elect Amy 
Hamlin, Treasurer Douglas Green-
baum, Secretary Heather Apicella, 
and of course, Immediate Past Chair 
Nicole Goetz.

During the luncheon, Lawrence 
Datz, now immediate past Chair of 
the Marital & Family Law Stand-
ing Committee, recognized those 
attorneys who have become newly 

Chair’s Message

Abigail Beebe
2018-2019 Section Chair

continued, next page
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board certified by The Florida Bar in 
the area of Marital & Family Law: 
Jordan Abramowitz, Christopher 
Russell Bruce, Matthew Paul Irwin, 
Catherine Magdalena Rodriguez, 
Katherine Cooper Scott, Michelle 
Klinger Smith and John Stephen 
Thacker. Congratulations! Former 
Section Chairs Thomas Sasser and 
Jorge Cestero administered the oath 
as we swore in our newest Executive 
Council members: Lauren Alperstein, 
Shannon McLin Carlyle, Reuben 
Doupé, Anastasia Garcia, Andrea 
Reid, Kimberly Rommel-Enright, 
Robin Scher, C. Debra Welch and 
Maxine Williams.

This year we already have begun 
our exciting line up of events, CLE’s 
and retreats. First, our bi-annual 
Leadership Retreat was held August 
23-26 at the Colony Hotel in Palm 
Beach, which was held in conjunction 
with the Section’s Fall Meetings. The 
Leadership Retreat was a HUGE suc-
cess and I encourage all members to 
participate in future years.

The goal, for this Leadership Re-
treat, was to give both Executive 
Council members and all members of 
the Section an opportunity to not only 
learn about the Section, our legisla-
tive process and leadership within 
the Section, but also to bring back the 
camaraderie of Section involvement. 
Another focus was to let all partici-
pants loosen up, lighten up and have 
FUN! We definitely did just that!!!

In October, Section members will 
put on their cowboy boots, cowboy 
hats and head to Nashville, Tennes-
see, for our Out-of-State Retreat. In 
Nashville, we will stay at the Thomp-
son Hotel, and the renowned Chris 
Mercer of Mercer Capital will bring 
us up to speed on the leading issues 
in the world of Business Valuations.

In January, partnering with the 
American Academy of Matrimonial 
Lawyers, Florida Chapter, for our An-
nual Certification & Review Course, 

Chair’s Message
from preceding page

which will take place at the Gay-
lord Palms in Orlando, Florida. This 
year the speakers are stellar and the 
lineup is not to be missed. As in years 
past, our Section’s Mid-Year Meetings 
will occur the day before the seminar, 
with the Executive Council meeting 
scheduled for just after the seminar.

In April, our Section is lucky 
enough to host our In-State Retreat 
at the private, exclusive and abso-
lutely beautiful Ocean Reef Club in 
Key Largo. This is sure to be one 
amazing experience for all.

Our Legislation Committee, along 
with the Executive Council and the 
entire section, are gearing up for 
what seems to be a busy legislative 
session ahead. We are teeing up to 
persevere through a busy legislative 
agenda. This year is also a Consti-
tutional Revision year, which occurs 
only every twenty (20) years. We want 
to educate our members, and the citi-
zens of Florida, to vote with as much 
knowledge and information as we can 
possibly provide.

It is a privilege and honor to be 
named Chair of this Section. At the 
Section’s Awards & Installation Lun-
cheon held on June 13, 2018, I was 
able to speak about my goals, “my 
theme,” and gave some of my thoughts 
about leadership within the Family 
Law Section.

For me, what this organization and 
volunteer work is all about, as well 
as my goal since I began this journey, 
was to try and help those involved 
recall why they became involved. It is 
our hard work and tireless efforts to 
ensure the families in this state are 
best served in every way.

In that process, I found, for me it 
was and is the dedication and devo-
tion to a cause that has always and 
will continue to have an impact. It is 
the hard work and tireless efforts of 
this Section to ensure the families in 
this state are best served, in every 
way.

In the Section, as a group, we talk 
about equality, marriage, equal rights, 
children’s voices and simply about 
people. Those people are Florida’s 

families. What hit me in preparing to 
become Chair was how grateful I am 
to have the opportunity to work for 
the Section, be a part of the process 
in making the laws of this state better 
for Florida’s families, and educating 
the Bench and Bar in family law. I 
am proud to be at the forefront of 
the legal issues facing the citizens 
of Florida.

Since my first Family Law Section 
meeting in 2007, I knew my heart 
was in this. I knew I was in the right 
place.  I have always been driven by 
my never-ending desire to make a 
difference, which is what kept me 
coming back, meeting after meeting 
and year after year. And just as I did 
at the luncheon, I challenge you, the 
members of this Section, to decide 
why you are here, what brought you 
to the table, and specifically to this 
Section of The Florida Bar. I ask you 
to think hard and recall.

If I could go back and tell my young-
er self one thing it would be this: 
“Abby, your efforts can make a differ-
ence. You are unstoppable when you 
want to be. Even if that difference is 
a small one. Change one child’s life, 
help one family, represent one child 
pro bono or one hundred. Change the 
world ... If it’s helping one person, it’s 
having an impact.”

So, to all of you: If I never get to 
personally tell you, your hard work is 
not unnoticed. You are doing amazing 
things. You are making a difference. 
Your impact will be remembered for 
years to come.

Each Chair before me has an-
nounced his or her “theme.” For me, 
I decided that the most important 
thing for me to say to each of you is 
this:  “Let’s remember what it was 
that brought us here. Don’t lose sight 
of that. Go back there. Recall it. Talk 
about it. What is YOUR purpose?”

In a world that is overrun with ar-
chaic ways of thinking about women, 
those who may not marry someone 
of the opposite sex, married versus 
unmarried biological parents, (which 
the Florida Supreme Court recently 

continued, page 6
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decided in Perkins v. Simmonds), the 
“others,” the rich, the poor, the power-
ful and the powerless—it’s this way of 
thinking that is destroying all of us.

So, I give you a few “rules” to guide 
you in your endeavors in life. Al-
though, I try to abide by these rules, 
sometimes successfully and most of 
the time basically learning as I go.

Rule One: Make failure your fuel.
Lesson: Fail with your head up, 

blow it, and then WIN.
Rule Two: Lead from the desk 

or bench.

Chair’s Message
from page 4

The lesson here is “you are al-
lowed to be disappointed when it 
feels like life has benched you.” What 
you aren’t allowed to do is miss your 
opportunity to lead from that bench. 
If you’re not a leader every day no 
matter what, don’t call yourself a 
leader at all. Either you are a leader 
everywhere or nowhere. Wherever 
you are put, lead from there.

Rule Three: Champion each 
other.

Joy, success, power. These are not 
pies where a bigger slice for one part 
means a smaller slice for you. Let’s 
claim joy, success and power—to-
gether.

Lesson: “A victory is also your vic-
tory. Celebrate it.”

Rule Four: Demand the floor if 
you have something to say. I hope 
this year you hear this message reso-
nate from the ceiling, wherever you 
are reading this.

MAKE A DIFFERENCE.
In closing, I ask you to close your 

eyes and go back, if it’s one year, 10 
or even 50 years, and remember why 
you are doing what you do.

Here’s to a great year—2018-19. 
Let this year be the year where we 
all make our mark. Have an impact!

Abigail Beebe, Esq.

Family Law Section 
Annual and Semi-Annual Sponsors

by Floridom

An Automated and Integrated Computational Family Law Case Management System  
for Family Lawyers, Mediators and Financial Planners

Platinum LevelSignature Annual Sponsor

Gold Level
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Nashville,Tennessee

Family Law Section 
Out-of-State Retreat

October 18 - 21, 2018 
Thompson Nashville 

Thank You to Our
Out-of-State Retreat

Sponsor!

 FOSTER · MORALES
SOCKEL · STONE
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Sonja Jean and I, Laura Davis Smith, are so excited to be co-

editors of the Publications Committee under esteemed Section 

Chair Abigail Beebe.  We look forward to continuing the Section’s 

history of producing informative and interesting publications, to 

entertain and to educate all of our members! We invite each of 

you reading this issue to get involved in one or more of the many 

committees the Section has to offer—including, of course, the 

Publications Committee! We would love to receive submissions 

for the Commentator, FAMSEG and the Florida Bar Journal. If 

interested, please reach out to Ms. Jean or to me, at our respective email addresses: lds@dsandjlaw.com 

and sj@dsandjlaw.com.

Message from the Co-Chairs 
of the Publications Committee

LAURA DAVIS SMITH and SONJA JEAN

Risk-free for six months.
www.FamilyLawSoftware.com       877-477-5488

Florida’s best...

 ■ Child Support.

 ■ Affidavit.

 ■ Alimony Calculators.

 ■ Electronic client data.

 ■ Desktop and Cloud.
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F. Scott Fitzgerald said “Life 
starts all over again when it 
gets crisp in the fall.” It is a 
new a season when Summer 
ends and we focus on taking 
stock of the goals we set for 
the year.  As we are all gear-
ing up for hard work to end 
the year,  we want to help you 
with the challenges faced as 
a family law practitioner.  In 
this issue of the Commentator 
you will find articles addressing topics which affect 
many areas of your practice. 

We are proud of the impressive authors who 
have submitted articles about these key issues 
which affect you in your practice and issues which 
affect your clients. You will find articles on the fol-
lowing: key immigration concepts, instructions on 
how to comply with change of name requirements 
in Florida, tackling the conflict between a Florida 
Family Law Rule of Procedure and Florida Statute 
regarding discovery obligations, addressing the is-
sue of the law regarding retroactive application of 
revocation-upon-divorce beneficiary designations, 
and critical tax considerations to consider when 

Message from the Co-Chairs 
of the Commentator

drafting Marital Settlement 
Agreements. This edition of 
the Commentator is sure to 
amaze.

A special tribute must 
be paid to Michelle Klinger 
Smith for contributing her 
time, intellect and talent as 
Guest Editor for this Fall 2018 
edition. And we would like 
to give a special thanks to 
the entire Commentator team 

including the authors and Co-Chairs of the Publica-
tion Committee, Laura Davis Smith and Sonja Jean. 
Our team’s inspiring engagement, dedication and 
thoughtful perspectives allow the Commentator to 
continue providing articles supporting the educa-
tion and growth of our readers. 

We also want to welcome our new Family Law Sec-
tion Chair Abigail Beebee, who is always a source 
of inspiration for the Section. 

We invite you to email us about topics you would 
like to see cover in future Commentator articles as 
we are all here with a similar mission: to help Flor-
ida’s families. It is with great enthusiasm that we 
present the Fall 2018 edition of the Commentator. 

www.familylawfla.org 

The Family Law Section's FAMSEG is a monthly e-newsletter that keeps section 

members apprised of section activity. It includes upcoming meetings, events and 

announcements, and occasionally features substantive topics of interest.

Visit FAMSEG and see what’s new!

ANASTASIA GARCIA ANYA CINTRON STERN
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Guest EDITOR’S CORNER
By Michelle Klinger Smith, Esq., Marathon

One of the ben-
efits of being ac-
tive in the Fam-
ily Law Section 
of The Florida 
Bar is the abil-
ity to build re-
lationships with 
colleagues from 
around the state. 

The practice of family law tends to be 
locality specific. You are often familiar 
with opposing counsel. Your practice 
may take you before the same judi-
ciary. Certain issues may appear over 
and over again because of your loca-
tion. Involvement in the Family Law 
Section expands your circle. You get 
to know attorneys and judiciary from 
around the state and become aware 

MICHELLE KLINGER SMITH

of issues others may experience based 
on their locations. If someone needs 
a referral for a family law attorney 
in Tallahassee, Jackson, Tampa, Or-
lando, Miami, etc., I can easily name 
a few attorneys from each area just 
from our mutual participation in the 
Family Law Section.

This edition of the Commentator 
expands on the concept of getting 
to know colleagues from around the 
state by including articles written by 
attorneys with different backgrounds 
that practice not only in Family Law, 
but in other areas: Wills, Trusts, and 
Estates: Alfred Stashis and Denise 
Carabon (both Florida Bar Board 
Certified in Wills, Trusts & Estates), 
and Miranda Weiss; Immigration 
and Nationality: Elizabeth Blandon 

(Florida Bar Board Certified in Im-
migration and Nationality); Family 
Law: Jerry Rumph, who is a Florida 
Supreme Court Certified mediator, 
and Carrington “Rusty” Madison 
Mead, who is a U.S. Navy Veteran. 
Also, this edition contains articles 
written by non-attorneys who are 
involved in the Family Law Section, 
including Lisa Tipton, who is the 
Family Law Section’s public relations 
professional, and Mary Elias, a foren-
sic accountant.

I thank everyone that has contrib-
uted to the Fall 2018 Edition of the 
Commentator and encourage others 
to become involved in the Family Law 
Section of The Florida Bar. Ideas, sug-
gestions, and different perspectives on 
family law issues are always welcome. 
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Beneficiary Designations in Divorce: 
Lessons from Sveen v. Melin

By Denise B. Cazobon, Esq. and Alfred J. Stashis, Jr., Esq. 
Naples

On June  11 , 
2018, the United 
States Supreme 
Court released its 
opinion in Sveen v. 
Melin. At issue in 
Sveen was the con-
stitutionality of the 
retroactive applica-
tion of Minnesota’s 
revocation-upon-
divorce statute to 
a life insurance 
beneficiary desig-
nation that was 
executed prior to 
the statute’s en-
actment. Under 
the statute, if one 
spouse named the 

other as beneficiary of a life insur-
ance policy or other similar asset, the 
divorce would automatically revoke 
that designation such that the pro-
ceeds would pass to the contingent 
beneficiary named or as otherwise 
provided under the contract. Melin 
challenged the retroactive applica-
tion of the Minnesota statute, argu-
ing that it violated the Contracts 
Clause of the U.S. Constitution by 
substantially impairing a contractual 
relationship. 

In 2012, Florida adopted a similar 
statute (Fla. Stat. § 732.703). Like the 
Minnesota statute at issue in Sveen, 
Florida’s statute also applies retroac-
tively to designations made prior to 
the statute’s enactment.

In an 8-1 decision, the Supreme 
Court ruled that Minnesota’s retro-
active application of the revocation-
upon-divorce statute to a life insur-
ance beneficiary designation does not 
violate the Contracts Clause of the 
U.S. Constitution. 

Sveen underscores the importance 

of specifically addressing beneficiary 
designations in divorce property set-
tlements as well as the importance of 
advising clients to consult with their 
estate planning attorneys once the 
final order of dissolution is entered.

Background information
In 1997, the decedent, Mark A. 

Sveen, married Kaye L. Melin. The 
following year, Sveen purchased a 
life insurance policy and designated 
Melin as primary beneficiary of the 
policy and his two adult children 
from a prior marriage as contingent 
beneficiaries. In 2002, subsequent 
to Sveen’s acquiring the policy and 
executing his beneficiary designation, 
Minnesota extended the application 
of its revocation-upon-divorce statute 
to life insurance beneficiary designa-
tions. Sveen and Melin divorced in 
2007. Their divorce decree made no 
mention of the life insurance policy. 
Sveen then died in 2011, never hav-
ing updated his beneficiary designa-
tion naming Melin.

The insurance company interplead-
ed and requested a determination 
as to whether Minnesota’s revoca-
tion-upon-divorce statute revoked 
the Sveen beneficiary designation. 
Melin argued that the retroactive 
application of the revocation-upon-
divorce statute was unconstitutional 
as an impermissible impairment of 
the Contracts Clause. The district 
court rejected Melin’s argument and 
granted summary judgment in favor 
of Sveen’s children.

Ruling from the Eighth 
Circuit Court of Appeals 
and a split of authority

The case was appealed to the 
United States Court of Appeals for 

the Eighth Circuit.1 Years prior, the 
Eighth Circuit had decided Whirlpool 
Corp. v. Ritter, which involved an 
Oklahoma revocation-upon-divorce 
statute enacted after the decedent 
husband had executed a beneficiary 
designation naming his then wife 
as beneficiary.2 The parties subse-
quently divorced, and the husband 
later died without having updated his 
beneficiary designation. In Whirlpool, 
the Eighth Circuit held that the au-
tomatic revocation of an ex-spouse’s 
beneficiary designation made prior 
to enactment of the statute violated 
the Contracts Clause. The court rea-
soned that there was a significant 
difference between changing the law 
with regard to yet-to-be-executed 
designations as opposed to designa-
tions already in place. In the former 
case, the parties can be expected to 
incorporate changes in law into their 
planning, whereas in the latter case, 
the parties expect their bargain to be 
protected in accordance with the law 
in effect at the time the designation 
was signed.3 At the time the dece-
dent husband designated his then 
wife as beneficiary, Oklahoma law 
provided that she would remain the 
beneficiary unless and until he des-
ignated someone else. The Oklahoma 
revocation-upon-divorce statute, by 
applying retroactively, disrupted that 
expectation. 

The Eighth Circuit determined 
Whirlpool to be controlling in Sveen 
and reversed the lower court’s rul-
ing, finding Minnesota’s revocation-
upon-death statute unconstitutional 
when applied retroactively to a life 
insurance beneficiary designation. 
The Eighth Circuit found that the 
Oklahoma and Minnesota statutes 
have the same effect – “to disrupt the 

continued, next page

DENISE CAZOBON

ALFRED STASHIS
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Beneficiary Designations 
in Divorce
from preceding page

policyholder’s expectations and rights 
to ‘rely on the law governing insur-
ance contracts as it existed when the 
contracts were made.’”4

In addition to the Eighth Circuit, 
the Pennsylvania Supreme Court 
has previously adopted a similar po-
sition.5 Whereas the Ninth Circuit6, 
Tenth Circuit7, South Dakota Su-
preme Court8, and Colorado Supreme 
Court9 have all held otherwise, find-
ing that such statutes do not violate 
the Contracts Clause of the U.S. Con-
stitution when applied retroactively. 
The Supreme Court’s ruling in Sveen 
resolved this split of authority among 
the lower courts.

Ruling of the United 
States Supreme Court 

In an 8-1 opinion written by Jus-
tice Kagan, the U.S. Supreme Court 
reversed the decision of the Eighth 
Circuit.

The Court first recognized the le-
gal system’s historical use of default 
rules to resolve estate litigation in a 
manner that conforms to decedents’ 
presumed intent. The Court further 
recognized that states have, over 
time, expanded the application of 
revocation-upon-death statutes from 
wills to will substitutes, such as re-
vocable trusts, certain retirement 
accounts, and life insurance policies. 
Such expansion is based upon the un-
derlying presumption that the typi-
cal decedent would no more want a 
former spouse to benefit from the 
decedent’s retirement plan or life in-
surance policy than to inherit under 
the decedent’s will.10 The Court also 
recognized that divorce courts have 
always had broad discretion to divide 
property between divorcing spouses, 
and in exercising that broad discre-
tion, courts could revoke beneficiary 
designations or mandate that prior 
designations remain in place, not-

withstanding any revocation-upon-
divorce statute that might otherwise 
apply. Similarly, the court reasoned, 
the policyholder might also take steps 
to override any revocation of an exist-
ing designation.11

Melin argued that applying the lat-
er-enacted revocation-upon-divorce 
statute to the decedent’s pre-existing 
life insurance policy designation vio-
lates the Contracts Clause. In deter-
mining whether a law violates the 
Contracts Clause, the Court applies a 
two-part test. First, the Court exam-
ines whether the state law operates 
as a “substantial impairment” of a 
contractual relationship. The Court 
considers the extent to which the law 
undermines the contractual bargain, 
interferes with a party’s reasonable 
expectations, and prevents a party 
from safeguarding or reinstating the 
party’s rights. If the factors show a 
substantial impairment, the Court 
then examines the means and ends 
of the law, asking whether the state 
law is drawn in an appropriate and 
reasonable way in order to advance 
a significant and legitimate public 
purpose.12

Applying the test to the case on 
hand, the Court found that, taken as 
a whole, the Minnesota statute does 
not substantially impair pre-existing 
contractual arrangements.13 While 
the law makes a significant change 
by revoking an existing beneficiary 
designation, the Court rejected Me-
lin’s argument that such change sub-
stantially impaired the decedent’s 
contract. In support of its finding, the 
Court reasoned that: 

(1) because an insured’s failure to 
change a beneficiary designation 
is more likely the result of neglect 
than choice, the statute is designed 
to reflect a likely policyholder’s 
intent, and the Minnesota statute 
therefore most likely honors, not 
undermines, the intent of the only 
contracting party to care about the 
beneficiary terms14; 

(2) the law is unlikely to disturb a 
policyholder’s expectations at the 
time of contracting because the 
statute does no more than a divorce 

court could have done; such courts 
have wide discretion to divide 
property between spouses when a 
marriage ends, meaning that the 
Minnesota law is unlikely to upset 
any expectations a policyholder 
may have had at the time of 
contracting15; and 

(3) the statute puts in place a mere 
default rule that the policyholder 
can easily undo by submitting a 
change of beneficiary form to 
the insurer or custodian [or by 
agreeing to continue the ex-spouse’s 
beneficiary status as part of the 
divorce settlement], and the Court 
has held in past cases that laws 
imposing minimal paperwork 
burdens such as these do not violate 
the Contracts Clause16.

Impact on Florida 
residents

Like Minnesota, Florida has enact-
ed a revocation-upon-divorce statute 
(Fla. Stat. § 732.703) which provides 
that a designation benefitting the 
decedent’s former spouse is void as 
of the time the decedent’s marriage 
is judicially dissolved or declared in-
valid by court order, if such designa-
tion was made prior to the dissolution 
or court order.17 If the statute applies, 
the decedent’s interest in the asset 
passes as if the decedent’s former 
spouse predeceased the decedent.18 

Fla. Stat. § 732.703 applies to 
employee benefit plans, individual 
retirement accounts, payable on 
death accounts, securities or other 
accounts registered in a transfer-on-
death form, life insurance policies, 
qualified annuities, and other similar 
tax-deferred contracts held within 
an employee benefit plan, and life 
insurance policies, annuities, and 
similar contracts not held within an 
employee benefit plan.19 The stat-
ute also contains certain exceptions 
to its application, including signifi-
cantly plans or policies governed by 
ERISA.20

Like the Minnesota statute at issue 
in Sveen, Fla. Stat. § 732.703 applies 
retroactively to all designations made 
by or on behalf of decedents dying 
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on or after July 1, 2012, regardless 
of when the designation was made.21 
The Supreme Court’s ruling in Sveen 
confirms that the retroactive applica-
tion of Fla. Stat. § 732.703 to designa-
tions signed before the July 1, 2012 
effective date does not violate the 
Contracts Clause of the U.S. Consti-
tution.

Advising clients during 
and after divorce 
proceedings

Although the Court’s opinion in 
Sveen provides some helpful clar-
ity, disputes relating to beneficiary 
designations can best be avoided or 
minimized through careful planning 
done during the client’s lifetime.

Wherever possible, the property 
settlement agreement should spe-
cifically address ownership and ben-
eficial interest of any assets subject 
to beneficiary designations, such as 
life insurance, retirement plans, em-
ployee benefit plans, or assets subject 
to pay-on-death or transfer-on-death 
designations. As discussed by Justice 
Gorsuch in his dissent, there are cir-
cumstances in which an ex-spouse 
may want to continue to designate his 
or her former spouse as a beneficiary, 
such as where the parties have minor 
children. For example, Justice Gor-
such points out that Melin had testi-
fied that she and the decedent had 
repeatedly agreed to maintain one 
another as designated beneficiaries of 
their respective life insurance policies 
because the premiums for such poli-
cies had been paid with funds derived 
from their joint bank accounts. How-
ever, that testimony alone was insuf-
ficient in and of itself, as the property 
settlement agreement between the 
parties was silent as to their respec-
tive life insurance policies, and Melin 
was otherwise unable to demonstrate 
by clear and convincing evidence that 
the decedent intended to continue to 
name her as his primary beneficiary. 

The best practice would be for the 
property settlement agreement to 

specifically identify each asset that is 
or can be subject to a beneficiary des-
ignation, which spouse owns such as-
set, whether the owner spouse must 
designate or continue to designate 
the former spouse as a beneficiary, 
or whether the owner spouse is free 
to dispose of such asset as he or she 
may choose. Once the order of dis-
solution is entered, the now divorced 
client should be encouraged to share 
a copy of the final order, as well as the 
property settlement agreement, with 
his or her estate planning attorney 
so that he or she might consider its 
implications for the client’s planning.  

It is common practice for some fam-
ily law judges to enjoin both spouses 
from making any changes to their 
beneficiary designations while the di-
vorce proceedings are pending; how-
ever, once the order of dissolution is 
entered, the former spouses should 
be advised to sign new beneficiary 
designations as soon as possible, even 
in instances where the client does 
not wish to change the designated 
beneficiaries. In addition to reduc-
ing the potential for future conflict 
among family members, by executing 
new beneficiary designations, clients 
can entirely avoid the impact of Fla. 
Stat. § 732.703 and any unintended 
consequences resulting from its ap-
plication. This is particularly true 
in rare cases in which one divorced 
spouse intends to continue to name 
his or her former spouse as beneficia-
ry, even though he or she may not be 
required to do so under the property 
settlement agreement. In such cases, 
the revocation-upon-divorce statute 
would otherwise likely frustrate that 
decedent’s intent.

For a number of reasons, clients 
often do not seek the advice of their 
estate planning attorneys either dur-
ing or immediately following divorce 
proceedings. They may feel over-
whelmed or emotionally drained by 
the process, they may not want to 
deal with any more lawyers for a 
while, or they may unwilling or un-

able to incur any further legal fees. 
It is not uncommon for several years 
to pass between the time the order of 
dissolution is entered and the time 
the client seeks to update his or her 
estate planning documents and bene-
ficiary designations. Such inattention 
can be costly however, particularly in 
cases where the client dies prior to 
ultimately updating his or her estate 
plan. Encouraging divorcing clients 
to consult with their estate planning 
attorneys throughout the process can 
help both to better assure that the 
client’s actual intent is carried out, 
and to reduce the potential for future 
litigation between the client’s benefi-
ciaries and his or her former spouse.  

Denise B. Cazobon is an associate 
and Alfred J. Stashis, Jr. is a share-
holder of Dunwody White & Landon, 
P.A. in Naples, FL.  Both are Florida 
Bar board certified in wills, trusts 
and estates.
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All Procedure and No Substance: 
The Conflict between Section 61.30(14), 

Florida Statutes, and Rule 12.285, 
Florida Family Law Rules of Procedure

By Jerry L. Rumph, Jr., Esq.
Tallahassee

Most  F lor ida 
family law practi-
tioners are prob-
ably familiar with 
the financial affida-
vit and mandatory 
financial disclosure 
requirements of 
rule 12.285, Florida 
Family Law Rules 

of Procedure, including its applica-
tion to proceedings to establish or 
modify child support and its time re-
quirements for producing documents 
in temporary, initial, and supplemen-
tal proceedings. The timing require-
ments of rule 12.285, subparagraph 
(b) states that any document required 
under the rule must be served (1) in 
temporary hearings, with the “notice 
of temporary financial hearing” by 
the party seeking relief and by the 
responding party, “on or before 5:00 
p.m., 2 business days before the day of 
the temporary financial relief hearing 
if served by delivery or 7 days before 
the day of the temporary financial 
relief hearing if served by mail or e-
mail;” or (2) within forty-five days of 
service of the initial pleading on the 
respondent in initial and supplemen-
tal proceedings. 

Fewer Florida family law prac-
titioners may be familiar with the 
requirements of section 61.30(14), 
Florida Statutes, which states:

Every petition for child support or 
for modification of child support 
shall be accompanied by an 
affidavit which shows the party’s 
income, allowable deductions, and 
net income computed in accordance 
with this section. The affidavit shall 

be served at the same time that the 
petition is served. The respondent, 
whether or not a stipulation is 
entered, shall make an affidavit 
which shows the party’s income, 
allowable deductions, and net 
income computed in accordance 
with this section. The respondent 
shall include his or her affidavit 
with the answer to the petition or 
as soon thereafter as is practicable, 
but in any case at least 72 hours 
prior to any hearing on the finances 
of either party.

Based on the above-quoted provi-
sions, a comparison of rule 12.285(b) 
and section 61.30(14) reveals a po-
tential conflict as to when an affi-
davit showing gross income, allow-
able deductions from gross income, 
and net income must be served in 
cases involving the establishment or 
modification of child support. This 
does not mean cases having child 
support as their sole issue, but every 
initial paternity, dissolution of mar-
riage, or modification proceeding in 
which child support is an issue. I 
say that a comparison of the rule 
and the statute reveals a “potential 
conflict” because the statute and rule 
do not request the exact same thing. 
Section 61.30(14) only requires an 
affidavit showing these three things: 
gross income, allowable deductions, 
and net income. Rule 12.285 requires 
the filing and service of a financial 
affidavit in “substantial conformity” 
with Florida Family Law Rules of 
Procedure Form 12.902(b) or (c). The 
financial affidavit begins with gross 
income, allowable deductions from 
gross income, and net income, but this 

is only a portion of the entire financial 
affidavit.

There are many family law at-
torneys who work with their clients 
to comply with rule 12.285, but far 
fewer, at least in my experience, who 
comply with section 61.30(14), prob-
ably because of a lack of knowledge 
regarding the section’s requirements. 
Due to this non-compliance, there 
have been cases in which a petition 
seeking child support has been at-
tacked with a motion to dismiss for 
failure to contain the affidavit re-
quired by section 61.30(14), but the 
court should grant leave to amend 
in such a case. See, e.g., Henderson v. 
Henderson, 882 So. 2d 499 (Fla. 1st 
DCA 2004) (holding that this was a 
technical deficiency with the peti-
tion). If there is an actual conflict 
between the statute and the rule, it 
should never be an issue for dismissal 
or striking of a pleading seeking to 
establish or modify child support be-
cause the timing requirements of the 
rule, not the statute, should govern.

When a rule of procedure conflicts 
with a statute on a matter of proce-
dure, the statute is unconstitutional, 
and the rule prevails. Art. V, §2(a), 
Fla. Const.; Haven Federal Sav. & 
Loan Ass’n v. Kirian, 579 So. 2d 730, 
732 (Fla. 1991). Procedure has been 
described as “the course, form, man-
ner, means, method, mode, order, pro-
cess or steps” a party takes in judicial 
proceedings as well as “the machinery 
of the judicial process as opposed 
to the product thereof,” as opposed 
to substantive law, which “creates, 
defines, and regulates rights, or that 
part of the law which courts are es-

JERRY L. RUMPH, JR.



tablished to administer.” Haven Fed-
eral Sav. & Loan Ass’n, 579 So. 2d at 
732. Generally, matters related to the 
time for filing or serving documents 
in a proceeding are procedural in na-
ture as they relate to “the machinery 
of the judicial process.” See, e.g., Ong 
v. Mike Guido Properties, 668 So. 2d 
708 (Fla. 5th DCA 1996); Saia Motor 
Freight Line, Inc. v. Reid, 930 So. 2d 
598 (Fla. 2006); Fla. R. Jud. Admin. 
2.514 and 2.516.

Given the potential conflict between 
section 61.30(14) and rule 12.285, what 
is the family law practitioner to do? A 
few options are available. If a petition 
involving child support has already 
been filed without the required affida-
vit and if that petition is attacked by a 
motion to dismiss for that reason, the 
petitioner can seek leave to amend to 
file the required affidavit. The request 
should be granted, or the petitioner 
may respond to the motion to dismiss 
by arguing that the rule trumps the 
statute, as discussed above. In fact, 
the Florida Third District Court of 
Appeal once contemplated this very 
argument in dicta. See Shou v. Mill-
er, 583 So. 2d 805, 806-07 (Fla. 3d 
DCA 1991) (decision quashed on other 
grounds). In Shou, the Third District 
Court of Appeal stated that if section 
61.30(12), now 61.30(14), conflicts with 
rule 1.611(a), Florida Statutes, which 
was the prior rule governing financial 
disclosure in dissolution of marriage 
actions, such a conflict would “repre-
sent an invalid legislative intrusion 
into the procedural rule making au-
thority of the supreme court.” Id.

If the petition has not yet been 
filed, the petitioner can file the peti-
tion without the affidavit required 
by section 61.30(14) and risk facing a 
motion to dismiss for failure to com-
ply with the statute. If the respon-
dent files a motion to dismiss, then 
the practitioner can choose between 
amending the pleading or fighting the 
motion to dismiss. The practitioner 
can wait until the client has complet-
ed his or her financial affidavit prior 
to filing the petition, but in dissolu-
tion of marriage actions, waiting may 
not be practical, such as when the 
petitioner in an original dissolution 
of marriage action wants to establish 
a cut-off date for identifying marital 
assets and liabilities under section 
61.075(7), Florida Statutes.

Possibly, the best practice is to com-
ply with both the rule and the stat-
ute, which should be relatively easy. 
As section 61.30(14) only requires 
gross income, allowable deductions, 
and net income, and not a full fi-
nancial affidavit, most parties know 
this information from memory or 
can readily access it. Just as many 
practitioners insert their UCCJEA 
allegations into a petition to establish 
or modify parenting, they can insert 
the petitioner’s gross income, allow-
able deductions, and net income into 
the petition as well. This should only 
require one additional paragraph to 
be added to the petition. In the al-
ternative, the practitioner may want 
to provide a brief, one-page affida-
vit containing this information and 
avoid the possible need to amend the 

petition down the road if it turns out 
that the information was incorrect. 
Of course, the practitioner needs to 
make sure to be as accurate as pos-
sible with this income information 
so that it aligns with the financial 
affidavit that will be required to be 
filed and served later in the case. 
In either scenario, complying with 
both the rule and the statute should 
give the practitioner the greatest 
peace of mind and obviate a challenge 
from the respondent, at least on these 
grounds. Such a practice will hope-
fully demonstrate to the court that 
the petitioner’s counsel is taking all 
disclosure requirements seriously, so 
the court can trust that practitioner 
to follow all legal requirements in the 
case. Finally, if the respondent does 
not comply with his or her disclosure 
requirements, it will give the peti-
tioner the greatest possible ammuni-
tion to show that he or she has been 
forthcoming in all aspects of financial 
disclosure.

Jerry L. Rumph, Jr., is a share-
holder with the law firm of Sweeting 
& Rumph, P.A., located in Tallahas-
see, Florida.  His practice focuses pri-
marily on all aspects of marital and 
family law, including collaborative 
practice as well as litigation.  Jerry is 
also certified by the Florida Supreme 
Court as a family mediator.  When not 
practicing law, Jerry enjoys spending 
time with his family, playing chess, 
and listening to songs about pina co-
ladas and getting caught in the rain.
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What’s in a Name? – Assisting Clients 
with Name Change Requirements 

in Florida
By Carrington Madison Mead, Esq.

Jacksonville

M o s t  f a m i l y 
law practitioners 
do not represent 
clients for name 
changes since the 
form issued by the 
Florida Family 
Laws of Procedure 
is straight forward, 
and pro se litigants 

can usually handle the matter on 
their own.1 However, there are times 
when litigants need assistance from 
a legal professional. 

Name changes have been more fre-
quently sought due to changes in 
federal laws relating to attempts to 
prevent false identification and to 
obtain more cohesive identification 
processes throughout each state to 
prevent terrorism within our borders. 
The Real ID Act of 2005 (The Act) was 
passed in May 11, 2005.2 Specifically 
Title II was added instructing states 
to minimally include the following 
information on any “driver’s license 
and identification card issued by the 
state:

(1) The person’s full legal name.
(2) The person’s date of birth.
(3) The person’s gender.
(4) The person’s driver’s license or 
identification card number.
(5) A digital photograph of the per-
son. 
(6) The person’s principal residence.
(7) The person’s signature.”3

as it addressed the necessary data 
pertaining to the individual issued 
the identity document.
The Act further sets forth require-

ments for the state to obtain evi-
dence of the individual’s lawful status 

as it concerned the citizenship and 
residency status of the individual 
to be issued identification.4 These 
requirements call for the individual 
to produce documents to validate 
their identity. This means the indi-
vidual needs to be able to provide 
a paper trail beginning with their 
birth certificate continuing to the last 
document that verifies the name they 
are currently using, if different than 
that which is found on their birth cer-
tificate. This requirement included a 
requirement that a state “shall enter 
into a memorandum of understand-
ing with the Secretary of Homeland 
Security to routinely utilize the au-
tomated System known as Systemic 
Alien Verification for Entitlements” 
no later than September 11, 2005. 
The Act set forth that “[b]eginning 3 
years after the date of the enactment 
of this division, a Federal agency may 
not accept, for any official purposes, a 
driver’s license or identification card 
issued by a state to any person unless 
the state is meeting the requirements 
of this section.”5

This federalization of identifica-
tion requirements for identification 
documents to be issued by the states 
has understandably caused a myriad 
of issues for three groups of citizens 
who often seek assistance of counsel: 
1) Senior citizens; 2) Immigrants; and 
3) Adults and children transitioning 
to another gender.

1. Senior Citizens
Senior citizens often need assis-

tance for two reasons. First, females 
may have been married several times 
and either cannot locate or obtain 

documents that evidence their mar-
riage or divorce. They may need as-
sistance in obtaining their documents 
to keep the name they currently go by 
or to be able to show the paper trail 
of how they obtained the name they 
are currently using. This is especially 
cumbersome with individuals who 
have changed their name numerous 
times. 

Secondly, many senior citizens, es-
pecially those born in southern states, 
may lack a birth certificate altogether 
or possess a birth certificate with a 
name on it that does not match the 
one they have on their identity docu-
ments (i.e. state driver’s license or 
identification card and social security 
card). Those who hobby in genealogy 
are familiar with this phenomenon, 
and are often frustrated by it. 

Before the necessity of social secu-
rity numbers which began in 1935 
and the issuing of state driver’s li-
censes, people didn’t have identity 
documents. Driver’s licenses in the 
United States were initially issued 
in 1910 in New York, not for iden-
tification but for the licensing of 
commercial drivers.6 Although, most 
states issued driver’s licenses for the 
purposes of operating a vehicle by 
1935, many people had same issued 
without much necessity to provide 
verification of identity.7 As driver’s 
licenses began to be used commonly 
as a method of identification, some 
states began issuing identification 
cards for residents who ask for state-
issued identification for non-driving 
purposes. There still existed no pat-
tern of requirement to prove who 
one was outside of presenting a birth 
certificate. 

CARRINGTON MEAD
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continued, next page

Those individuals lacking birth cer-
tificates could verify identity with an 
affidavit for someone who was able 
to state they knew the person all 
their lives, knew the individual per-
sonally, and knew their name.8 The 
most likely individuals to lack a birth 
certificate were those born in rural 
areas of the South. Often, the parents 
could not afford the fees required for 
the issuance of a birth certificate and 
did find a necessity for doing so, be-
yond recording the birth in the family 
bible. This often resulted in the name 
the child went by changing as they 
matured, and family members felt 
another name was more befitting.9 
Under these circumstances many 
senior citizens possess identification 
documents that show the name they 
go by, not the name they were given 
at birth. These circumstances require 
assistance at times due to the individ-
ual’s lack of ability to provide docu-
mentation the court desires because 
of lack of knowledge. Affidavits from 

family and/or individuals who have 
known the petitioner all their life are 
key. Anyone signing an affidavit will 
be required to produce identification 
to establish their own identity.

2. Immigrants
Immigrants find a need for a name 

change for two reasons: 1) Their name 
is misspelled on immigration docu-
ments; and 2) They desire to “Ameri-
canize” their name to better blend 
in with their fellow citizens. Those 
who have sat around their kitchen 
table with extended family mem-
bers recounting stories of the past 
may have heard immigration stories 
that include the change of the family 
surname because of misspelling by a 
clerk upon entry to the country or an 
attempt to shirk ethnic identity that 
may subject the individual to dis-
crimination in their new homeland. 
Due to the environment as it pertains 
to identity documents, as described 

above, those who came in earlier were 
able to experiment with a myriad of 
spellings until finding one spelling 
they were comfortable. 

On some occasions, there is no at-
tempt to document the name differ-
ently than from that given to them 
in their country of birth. In these 
cases, the family socially uses a more 
Eurocentric name to make it easier 
for the individual to socially inte-
grate in their communities. This is 
common with the children in these 
families. Some of these children grow 
up to be adults who are not aware of 
what their real first name is, having 
never had need to look at their birth 
certificate. Meanwhile, they possess 
identity documents that contain the 
name they have always used. This 
is because most of us who are in our 
forties and above did not obtain a 
social security card until our teenage 
years, when we decided to go to work 
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at sixteen. Prior to this there was 
no need for a social security card or 
an identity document. By this point 
the individual was used to filling 
out documents with the name they 
used. Although this is most common 
amongst immigrants it also occurs in 
the normative population.10

3. Adults and Children 
Transitioning to Another 
Gender11

a. Adults
The central issue with adults tran-

sitioning to a gender different from 
that which they are identified as on 
their birth certificate is that which re-
lates to the criminal status of the indi-
vidual who requests a name change.12 
These individuals are at a higher risk 
of participating in activity that is 
likely to find them arrested or gain-
ing the attention of law enforcement 
officers (LEOs). This population is 
eight times more likely to participate 
in sex work in comparison to women 
for survival.13 They are also likely to 
commit drug related crimes.14 Thus, 
the requirement in the Florida Stat-
ute to report “[w]hether the petitioner 
has ever been arrested for or charged 
with, pled guilty or nolo contendere 
to, or been found to have commit-
ted a criminal offense, regardless 
of adjudication, and if so, when and 
where” can present problems for a 
petitioner in this case.15 This Statute 
also requires the individual to state 
whether they have ever registered or 
are registered as a sexual predator or 
offender.16 The Statute then requires 
the individual to state that their “civil 
rights have never been suspended 
or, if the petitioner’s civil rights has 
been suspended, that full restoration 
of civil rights has occurred.”17 Most 
practitioners read these sections and 
advise those seeking assistance be-
cause they have been arrested, or 
processed for a crime, that they are 
unable to assist the petitioner and 

that a name change cannot and will 
not be granted. However, this is an 
inaccurate assessment. 

The section of the Statute introduc-
ing the criminal record of a petitioner 
did not exist until June 15, 1995 and 
has seen subsequent changes fur-
ther flushing it out on July 1, 2004.18 
The section of the Statute address-
ing registering as a sexual offender 
or predator was passed and became 
effective on July 1, 2014. The Statute 
also specifically requires the clerk of 
the court to send a report along with 
the final judgment to the Florida 
Department of Law Enforcement.19 
What is of particular interest is that 
the Statute further states,

“If the petitioner is required to 
register as a sexual predator or 
a sexual offender pursuant to 
s. 775.21 or s. 943.0435, the clerk of 
court shall electronically notify the 
Department of Law Enforcement 
of the name change, in a manner 
prescribed by that department, 
within 2 business days after the 
filing of the final judgment.”20

Thus, clearly the legislature as-
sumes petitioners with convictions 
for felonies can and will petition the 
court for a name change and are like-
ly to have same granted. Ostensibly, 
these same petitioners, who have felo-
nies, will not have their voting and 
gun rights restored in Florida. This 
is further evidenced by The Florida 
Supreme Court, in 1991, wherein 
they overturned a denial of a petition 
without granting a hearing because 
the petitioner was incarcerated.21 The 
court’s assumption the petitioner was 
ineligible was judicial error.22

This issue was further flushed out 
in a Fourth District Court of Appeals 
case wherein another petitioner, Mul-
lin, with a prior felony was denied a 
name change because of his criminal 
record and “ha[d] not had his civil 
rights restored.”23 Mullin argued that 
the court was not allowed to consider 
the felony since the conviction was 
entered prior to the effective date 
of the applicable statute, which was 
June 15, 1995, and the appellate court 

agreed.24 The Mullins court repeated 
the necessity of granting a petition 
“in the absence of a evidence of a 
wrongful or fraudulent purpose.”25 
The dissent in Mullins is worth read-
ing since it discusses how the statute 
may run afoul of First Amendment 
rights.

b. Children
Children in this situation are not 

going to have the same issues with 
criminal arrests and convictions that 
adults do. However, they will face 
conflict in obtaining the name change 
when parents disagree. Interestingly, 
the statute allows a parent to petition 
the court alone, without the necessity 
of being joined by the other parent.26 
The interesting part of this section 
allows the petitioning parent a choice 
of notice, either personal or construc-
tive.27

Many practitioners may feel name 
changes are far too simplistic an area 
to practice in but underestimate the 
need for a skilled attorney to advocate 
on behalf of a litigant. Others do it 
because they think it’s simple. Al-
though, the latter may be true a good 
bit of the time, there are plenty of 
litigants who need assistance. Prac-
titioners are advised to think twice 
about turning down the opportunity 
but should measure the depth of the 
water before they leap.

Carrington Mead, Esq., runs a full-
service firm in Jacksonville, Florida, 
focusing on Family Law, Estate Plan-
ning, Probate and Guardianship. He 
is a U.S. Navy Veteran. He is a vetted 
member of the Family Law Institute 
co-sponsored by the National LGBT 
Bar Association and National Center 
for Lesbian Rights. He is also a fellow 
of the American Bar Foundation in 
recognition of his long history of us-
ing his legal skills for social advocacy.

Endnotes
1 Florida Family Law Rules of Procedure 
Form 12.982(a) Adult; 12.982(c) minor; and 
12.982(e) Family. For the purposes of this ar-
ticle the author will not discuss each section of 
the petition but instead the complicating is-
sues that appear in serving clients requesting 
name changes. 
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2 Public Law 109-13-May 11, 2005 119 
STAT.309 – Real ID Act of 2005.
3 Real ID Act of 2005, Title II, Sec. 202(b).
4 ibid, at Sec. 202(c)(2)(B).
5 ibid, at Sec. 202(a)(1).
6 42 U.S.C. Code §901; and https:/ /
en.wikipedia.org/wiki/Driver%27s_license 
7 https://en.wikipedia.org/wiki/Driver%27s 
licenses_in_the_United_States. 
8 This information is based on the author’s 
actual knowledge of the process. It is important 
to note this information has been supported by 
many clients of the author who have also anec-
dotally shared this information. Other clients 
have also indicated that agency offices in rural 
areas were less likely to require an affidavit as 
described herein and instead would accept a 
sworn statement from the applicant. 
9 This occurred three times in the author’s 
family. Genealogy records show his maternal 
grandfather’s first name changing three times 
in his birth certificate and census records when 
recorded while residing his family, which in-
cluded his twin brother. Two other family mem-
bers also had their name changed anecdotally 
and recorded in official government records.
10 Wages v. State, 160 So.3d 100 (Fla. 4th DCA 

2015). Wages requested a name change to be 
able to conform with the National Real ID Act 
of 2005. Although his birth certificate showed a 
name he was given upon birth, his Mother later 
requested a social security card for her son and 
registered him under a completely different 
name. Wages used this name for his lifetime 
and always identified by this second name, 
including when he was arrested and convicted 
of misdemeanors and declared bankruptcy.
11 For purposes of this discussion the author 
will not be discussing the nuances of obtain-
ing gender marker changes through the courts 
when necessary.
12 Florida Statutes §68.07(3)(h) (2018).
13 Grant, Jaime M., Lisa A. Mottet, Justin 
Tanis, Jack Harrison, Jody L. Herman, and 
Mara Keisling. Injustice at Every Turn: A Re-
port of the National Transgender Discrimina-
tion Survey. Washington: National Center for 
Transgender Equality and National Gay and 
Lesbian Task Force, 2011, p. 22.
14 ibid.
15 Florida Statutes §68.07(2)(h) (2018).
16 Florida Statutes §68.07(2)(i) (2018).
17 Florida Statutes §68.07(2)(l) (2018).
18 Florida Statutes §68.07(2)(h) (1995) effec-

tive June 15, 1995; Florida Statutes §68.07(2)
(h) (2004) effective July 1, 2004 The previous 
Statute only asked for felony convictions. The 
subsequent change includes misdemeanors 
and arrests.
19 Florida Statutes §68.07(6) (2018).
20 ibid.
21 Gosby v. Third Judicial Circuit, et al., 586 
So.2d 1056, 1057 (Fla, 1991) “even if a peti-
tioner for a name change is incarcerated, he 
is entitled to a ruling on his petition. Other 
district courts have held that a prisoner’s fa-
cially sufficient name change petition should 
be granted where there is no evidence to sup-
port any ulterior or illegal purposes.”
22  ibid.
23 In re NAME CHANGE PETITION OF 
Bryan Patrick MULLIN., a/k/a Patrick Bryan 
Mullin, 892 So. 2d 1214 (Fla. 2nd DCA. 2005); 
Finfrock v. State, 932 So.2d 437 (Fla. 4th DCA 
2006).
24 ibid.
25 ibid.
26 Florida Statutes §68.07(8) (2018).
27 ibid. In re Benitez, No. 3D17-1502 (Fla. 3d 
DCA 2018).
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PowerPoint Pro Tips
Lisa M. Tipton APR – PR Florida Inc.

Family Law Section Communications Consultant
Florida/Arkansas

Need some ideas on how to take 
your PowerPoint skills to the next 
level? This article is a compilation of 
some of the best pro tips out there for 
PowerPoint 2016—formatting, video, 
transitions and even font size—that 
hopefully will take your next presenta-
tion from “blah” to “WOW.”

Follow the 10/20/30 Rule. Venture 
capitalist Guy Kawasaki says a PowerPoint presentation 
should have 10 slides, last no more than 20 minutes and 
contain font no smaller than 30 points. 

-  10. According to Kawasaki, 10 is the optimal number 
of slides because people can’t comprehend more than 
10 concepts in one meeting. 

- 20. For a one-hour presentation, factor in time to 
make your presentation work with the projector, 
interruptions from people coming and going and the 
inevitable technical difficulties. In a perfect world, 
if you give your pitch in twenty minutes you have 
forty minutes left for Q & A.

- 30. How many times have you seen as much text as 
possible crammed into the slide and then the pre-
senter reads it word for word? Not only is it boring, 
Kawasaki says this is a no-no because the audience 
ends up reading ahead of you faster than you can 
speak. Use fonts no smaller than 30 points and you’ll 
be forced to identify the most relevant parts of your 
presentation and learn how to talk about them.

Use Designer to Create 
Amazing Layouts. Who has 
the time or ability to design 
eye-catching presentations? 
Thankfully, the PowerPoint 
Designer feature uses your text 
and images and creates slide 
layout suggestions for you.

- Create a new presentation 
a n d  c h o o s e  o n e  o f 
PowerPo in t ’s  bu i l t - in 
themes.

- Click File > Options > 
General and check the box 
for “Automatically show me 
design ideas.”

LISA TIPTON

- Use Insert to add your content. Using pictures and 
charts gives Designer more to work with. Designer 
can even turn bulleted list into graphics. You must 
be connected to the internet and using one of 
PowerPoint’s themes for Designer to work in the 
background.

Add Audio and Video. Adding sound to your Power-
Point is super easy. Just click Insert > Audio and select 
the music file you want to include. You can also do the 
same with video; PowerPoint even allows you to search 
for and embed online videos from YouTube. But did you 
know you also can record audio voiceover directly into 
your presentation? Use your computer’s built-in micro-
phone or connect a USB microphone to your computer 
for better quality.

- Choose the slide onto which you want to record the 
audio. 

- Click Insert > Audio > Record Audio. 
- Name the audio, then click the red record button to 

start recording. When you finish, click the blue 
square to stop recording. Click Play to check how it 
sounds. You can re-record it by following the same 
steps.

- When you’ve got a recording that works, click OK 
and your audio will appear as a speaker icon in the 
center of the screen. 

Navigate with Zoom. Are you still clicking through 
PowerPoint presentations one slide at a time? Zoom lets 
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you navigate around your presentation in a more inter-
esting way. By creating a Zoom, you can jump to and from 
specific slides and sections in an order you decide. Maybe 
you have one slide that summarizes your key points. 
Zoom lets you jump to the slide you want and then go 
right back to your place in the presentation. 

- Click Insert > Zoom.
- Summary Zoom lets you see all of your presentation 

slides at one time. Slide Zoom allows you to jump to 
a single slide anywhere in your presentation and a 
Section Zoom is a link to a section already in your 
presentation. You can use it to go back to sections 
you want to really emphasize or to highlight how 
certain pieces of your presentation connect.

Zoom for PowerPoint is only available to Office 365 
subscribers and only on Windows. Use Zoom Tools on the 
Format menu to customize transitions and backgrounds.

Morph It. Morph is an easier, faster way to create 
animations—and it’s available with an Office 365 sub-
scription. Morph creates the appearance of movement 
in text, shapes, pictures, SmartArt, WordArt and charts.

- Duplicate one of your slides, then edit the duplicate 
slide by moving objects around, adding or removing 
text, changing graphics and colors, etc. Note: The two 
slides you are connecting need to have at least one 
object in common such as text, a shape, a picture or 
a chart.

- On the Transitions tab, select Morph. PowerPoint 
will automatically animate the changes you made. 

Use Your Smartphone as a Remote and Laser 
Pointer. Have you ever been distracted by a presenter 
who can’t seem to get the transitions right, or worse, 
stops speaking because he or she is trying to advance 
slides using a laptop? Avoid this by turning your phone 
into a presentation tool. 

- Download the free PowerPoint app for Android, 
iPhone, or Windows phones.

- Connect your phone to the projector with an HDMI 
cable or WiFi through AirPlay or ChromeCast.

- Bonus: You can create and share presentations on 
the PowerPoint app and then continue working on 
them once you get back to your computer.

Convert Your Presentation Into Video. Not every-
one has PowerPoint on their computers, and sometimes 
you might want to share your amazing PowerPoint on 
social media or post it to your website. It’s easy to cre-
ate a video and pick a format that works for the location 
where you’d like to share it.

- Save all of your changes, then go to File > Export > 
Create a Video. All of your timings, narrations, ani-
mations and transitions will be retained.

- Select the resolution for your video and decide if you 
want to include slide timings and narrations. Next, 
choose a default time for each slide to appear on the 
screen and then click Create Video.

- Name your file, choose your file type and save it to 
your computer. MP4 format is a good choice because 
it’s supported by common social media sites like 
Facebook and Twitter. Click Save to generate your 
video.

If you’re looking for more resources on how to take your 
PowerPoint skills to the next level, you can find many 
easy-to-follow tutorials on YouTube and in Microsoft 
Office Support.

Lisa McKnight Tipton is a nationally accredited 
PR professional who implements communications and 
marketing strategies for legal associations, law firms, 
nonprofits and corporate clients. Her more than 30 years 
of public relations experience includes 14 years as a con-
sultant to The Florida Bar, promoting its board certifica-
tion program, its Family Law, Solo & Small Firm and 
Alternative Dispute Resolution sections and numerous 
special events. PR Florida Inc. is her communications 
consulting company. Connect with her at lisa@prflorida.
com or on LinkedIn.
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Tax Considerations for Marital Agreements
By Miranda M. Weiss and Alfred J. Stashis, Jr.

Dunwody White & Landon, P.A., Naples 

When drafting 
mar i ta l  agree -
ments, due con-
sideration is not 
always given to 
relevant tax pro-
visions. Such pro-
visions can po-
tentially result 
in significant tax 
savings to one or 
both parties. Mari-
tal and family law 
attorneys should 
recognize the value 
of various tax pro-
visions in order to 
ensure their clients 
are maximizing 
potential benefits. 

This Article addresses various con-
siderations to keep in mind when 
representing clients contemplating 
marital agreements.

Gifts during Marriage
During the marriage, each spouse 

may wish to retain the ability to free-
ly make gifts to or for the benefit of 
other individuals and/or charities, 
including family members and po-
tentially the other spouse, as may be 
desired. For example:

Sample Language 1:1 Gifts. 
Nothing in this Agreement shall be 
considered a waiver by either party 
to make gifts to the other, but this 
provision shall not be construed as 
a promise or representation that 
any such gift, bequest or devise 
will be made. [Spouse 1] recognizes 
that [Spouse 2] may wish to confer 
gifts or benefits on others, including 
his/her family members, whether 
by gifts or other transfers during 
lifetime or by inheritance upon 
death. [Spouse 2] recognizes that 
[Spouse 1] may wish to confer gifts or 
benefits on others, including his/her 

family members, whether by gifts or 
other transfers during lifetime or by 
inheritance upon death. Each party 
agrees that the other shall have an 
unlimited, unfettered right to do so 
without any limitation, restrictions 
or impairment except as otherwise 
provided in this Agreement. 

Lifetime gifts between U.S. citizen 
spouses qualify for the unlimited 
marital gift tax deduction.2 Gifts 
to other individuals qualify for the 
annual gift tax exclusion, which is 
$15,000 as of January 1, 2018.3

Spouses who agree to split gifts in 
the taxable year may make tax-free 
gifts to any individual up to $30,000 
per donee per year.4 This gift-splitting 
option doubles the amount that one 
spouse may give to an individual in 
the taxable year, and can result in 
substantial tax savings over time. 
For example, assume Spouse 1 and 
Spouse 2 agree to gift split annual 
exclusion gifts. During years 1-10, 
Spouse 1 makes gifts of $30,000 each 
year to ten individuals, including four 
children and six grandchildren.5 If 
Spouse 2 agrees to gift split during 
each of those years, the result will be 
that all $3,000,000 worth of Spouse 1’s 
gifts to family members will be cov-
ered by annual exclusions and nei-
ther Spouse will utilize any of their 
available lifetime gift tax exemption 
or GST tax exemption.6 If Spouse 2 
had not consented to gift splitting in 
the foregoing example, then Spouse 1 
would have made $1,500,000 of tax-
able gifts during years 1-10, thereby 
utilizing $1,500,000 of lifetime gift 
exemption and $900,000 of lifetime 
GST tax exemption.7 Or, if Spouse 1 
had no available exemption remain-
ing, Spouse 1 would be responsible to 
pay approximately $388,000 in gift 
tax and $360,000 in GST tax. 

Thus, one tax consideration at-
torneys should address in drafting 
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marital agreements is the agreement 
to split gifts. Of course, the marital 
agreement should also specify who is 
liable for the tax due, if any, on gifts 
made in excess of the annual exclu-
sion amount when spouses consent 
to split gifts since both spouses will 
otherwise be individually liable for 
the tax. The sample language be-
low contemplates that when spouses 
elect to split gifts, the donor gifting 
the property will bear the gift tax 
liability in excess of the exemption 
amount. For example, if Spouse 1 
and Spouse 2 agree to gift split, and 
Spouse 1 gifts $500,000 of Spouse 1’s 
separate property to Spouse 1’s son, 
and there is insufficient gift tax ex-
emption available, then Spouse 1 
would bear the gift tax liability for 
the amount in excess of the $30,000 
annual exclusion amount.

Sample Language 2: Gift Splitting. 
If the parties elect to split gifts for 
federal gift tax purposes, each party 
shall pay his or her proportionate 
share of all gift taxes due, if any, 
calculated according to each party’s 
proportionate ownership interest in 
the Separate Property and Marital 
Property gifted.

Given that the lifetime gift tax 
exemption amount has increased 
to $11.18 Million per spouse as of 
January 1, 2018, in cases where one 
spouse is significantly wealthier than 
the other, there can be significant 
value to the wealthier spouse in hav-
ing the ability to avail of the less 
wealthy spouse’s lifetime gift exemp-
tion through gift splitting. Consider 
the case where Spouse 1 has a net 
worth of $20 Million and unused gift 
tax exemption of $5 Million, while 
Spouse 2 has a net worth of $2 Mil-
lion and unused gift tax exemption 
of $11.18 Million. If gift splitting is 
elected, Spouse 1 could make gifts 
of $10 Million to his/her children by 
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utilizing Spouse 1’s remaining $5 
Million gift exemption and $5 Million 
of Spouse 2’s gift exemption, with 
no gift tax due. Spouse 2 would still 
have $6.18 Million of available gift 
exemption remaining after Spouse 1’s 
gifts under current law, which is more 
than sufficient to cover Spouse 2’s 
$2 Million in assets, including the 
likely growth thereupon. If gift split-
ting were not elected in the foregoing 
example, the same $10 Million worth 
of gifts made by Spouse 1 would have 
triggered approximately $2 Million 
(40% of $5 Million) in gift tax for 
Spouse 1. 

Income Tax Returns 
During Marriage

Couples must decide whether they 
will file their income tax returns 
jointly or separately during their 
marriage. Generally, spouses who 
choose to file joint returns receive 
greater tax relief than those who file 
separately. This is because a lower 
top marginal tax rate is generally 
available to couples filing jointly, as 
are greater exclusions and credits.

It can be helpful to run the num-
bers in each case to see whether a 
joint return will result in overall tax 
savings. When there is a significant 
discrepancy in earnings between the 
spouses, filing jointly will generally 
result in a lower top marginal tax rate 
for the higher earning spouse. For 
example, assume Spouse 1’s taxable 
income is $175,000 and Spouse 2’s 
taxable income is $50,000. In 2018, if 
both spouses file separately, Spouse 1 
would be in the 32% top marginal 
tax bracket and Spouse 2 would be 
in the 22% top marginal tax bracket. 
Whereas, if Spouse 1 and Spouse 2 
agreed to file their income tax return 
jointly, their top marginal tax rate 
would be 22%—a 10% decrease for 
Spouse 1. 

Although tax savings are a sig-
nificant variable, drafters of marital 
agreements must also address the 
liability for payment of any taxes due 
under a joint return. A common ap-
proach is to provide that each spouse 

must pay his or her proportionate 
share of the overall income taxes, as 
follows:

Sample Language 3: Tax Returns. 
If both parties agree, they shall file 
joint income tax returns during 
the marriage. Otherwise, the 
parties shall file separate income 
tax returns and pay their own 
taxes, interest and penalties as 
well as costs of preparation. If the 
parties file joint income tax returns, 
each party shall pay his or her 
proportionate share of all income 
taxes. The proportionate share 
of each party shall be an amount 
bearing the same ratio to the total 
joint tax liability for the period 
covered by the return that (1) the 
amount of income tax for which 
each party would have been liable, 
if the party had filed a separate 
return for the period reporting the 
items of income, deduction, gain, 
loss, credit, etc. bears to (2) the 
total of the amounts for which both 
parties would have been liable if 
both had filed separate returns for 
that period. The filing of any joint 
income tax return shall in no way 
modify or be regarded as modifying, 
explicitly or implicitly, any of the 
terms of this Agreement, and the 
inclusion of any item of income 
classified as Separate Property, 
or any proceeds from the sale, 
exchange of investment of Separate 
Property, as reported or reportable 
on any jointly filed federal income 
tax return during the marriage, 
shall not convert such income 
or property to Marital Property 
or permit the other to claim any 
legal or equitable interest thereto 
or therein. If interest or penalties 
become due on a joint return, 
the party responsible for causing 
such penalty or interest shall pay 
the interest or penalty. If neither 
party is directly responsible, or if 
both parties are responsible, such 
interest or penalty shall be the 
obligation of and paid by the parties 
in the same proportion as the taxes 
for that year. 

For example, assume that if sep-
arate returns were filed for 2018, 
Spouse 1 would owe $50,000 in in-
come tax and Spouse 2 would owe 

$10,000 in income tax; whereas if a 
joint return were filed, the total tax 
due would be $55,000. Under the 
above formula, Spouse 1 would be li-
able for $45,833.33 = $50,000/$60,000 
or 83.33 percent of the $55,000 
taxes due under the joint return, 
and Spouse 2 would be liable for 
$9,166.67 = $10,000/$60,000 or 16.67 
percent of the $55,000 taxes due un-
der the joint return. 

As illustrated, planning for the fil-
ing of joint returns may result in tax 
savings for one or both spouses. At-
torneys and advisors for both spouses 
should consider whether filing a joint 
return would benefit their clients and, 
if so, how to structure the method for 
determining payment responsibility. 

Tax Issues in the Event of 
a Divorce

The Internal Revenue Code pro-
vides that no gain or loss is recog-
nized on a transfer of property from 
one individual to a former spouse 
if the transfer is made incident to 
divorce.8 The Internal Revenue Code 
further provides that any transfers of 
property or interests made pursuant 
to a written settlement agreement 
where divorce occurs within three 
years after the date beginning one 
year before the agreement is entered 
into shall be deemed to be a transfer 
made for full and adequate consid-
eration in money or money’s worth.9 

Under current law, effective until 
December 31, 2018, alimony paid 
under a divorce or separation in-
strument is deductible by the payer, 
and the recipient must include such 
amounts in his or her income.10 The 
payer can deduct alimony whether or 
not the payer itemizes deductions.11 
Significantly, however, the 2017 Tax 
Cuts and Jobs Act provides that ali-
mony payments made pursuant to a 
divorce agreement finalized or modi-
fied after December 31, 2018 will no 
longer be deductible to the payer or 
includible as income to the recipi-
ent.12 Alimony paid pursuant to a di-
vorce or separate agreement executed 

continued, next page
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Tax Considerations for 
Marital Agreements
from preceding page

prior to January 1, 2019 will continue 
to be deductible to the payer and re-
portable as income to the recipient as 
under current law. 

While many provisions of the 2017 
Tax Cuts and Jobs Act provide for 
a sunset date, the non-deductibility 
of alimony payments and inclusion 
of such payments in gross income 
does not sunset. Thus, wealthy clients 
who divorce and are required to pay 
alimony will lose substantial current 
tax benefits over time. Family law 
attorneys should therefore consider 
adding certain language to marital 
agreements to address potential ad-
justments to alimony payments in 
order to attempt to maintain close to 
the status quo, as follows: 

Sample Language 4: Alimony 
Payments. At any time or times 
that alimony is payable under this 
Agreement and such alimony is 
not deductible to the payer under 
the Internal Revenue Code and 
not includible in the payee’s gross 
income under the Internal Revenue 
Code, then such alimony payments 
shall be reduced by the average tax 
rate of the Parties, as determined 
using the average marginal tax 
rate of both parties for the year 
immediately preceding the year of 
payment.13

The language above provides that 
alimony payments will be reduced by 
an amount equal to the estimated tax 
allocable to the alimony payment, as 
determined by calculating the aver-
age tax liability of the payer and 
the payee for the prior year. Assume 
that the preliminary alimony amount 
of $50,000 is due in 2020, Spouse 1 
had 2019 income of $150,000 and a 
24% average marginal tax rate, while 
Spouse 2 had 2019 income of $70,000 
and a 22% average marginal tax rate. 
The average marginal tax rate of the 
spouses for the year immediately 
preceding the year of payment is 

therefore 23%. The tentative alimony 
payment amount of $50,000 in 2020 
would be reduced by $11,500 in esti-
mated tax and an alimony payment 
of $38,500 would be made in 2020. 

Because over time the inability to 
deduct alimony payments will likely 
result in the loss of substantial tax 
deductions to the payer and a sub-
stantial tax-free benefit to the re-
cipient, attorneys should consider 
including language in marital agree-
ments which adjusts the manner for 
calculating required annual alimony 
payments.

Death of Spouse 
The Internal Revenue Code pro-

vides that marital bequests made by 
a deceased US citizen to a surviving 
US citizen spouse qualify for the un-
limited estate tax marital deduction 
if such bequests are made either out-
right or in the form of qualified ter-
minable interest property (QTIP).14 
Outright bequests are simplest; how-
ever many decedents will choose to 
provide for their surviving spouse via 
a QTIP Marital Trust. In addition to 
offering better creditor protection, the 
QTIP approach allows the deceased 
spouse to control ultimate disposition 
of the trust assets upon the surviving 
spouse’s subsequent death.

An often overlooked provision is 
the estate tax portability election. 
This election provides the surviving 
spouse with the opportunity to in-
crease his or her basic $11.18 Million 
exclusion amount by the amount of 
estate tax exemption which was not 
utilized by the deceased spouse (the 
“Deceased Spousal Unused Exclusion 
Amount” or “DSUE amount”).

For example, consider two indi-
viduals contemplating marriage. 
Spouse 1 has an estimated taxable 
estate of $25 Million. Spouse 2 has 
an estimated taxable estate of $2 
Million. Spouse 1 would likely want 
his/her marital agreement to pro-
vide that if Spouse 2 predeceases 
Spouse 1, the Personal Representa-
tive for Spouse 2’s Estate will make a 
portability election, so that Spouse 1 

may take advantage of the Spouse 2’s 
DSUE amount.15 Under the foregoing 
example, if Spouse 2 died in 2018 
having made no lifetime taxable gifts, 
and the portability election is made 
on a timely filed federal estate tax 
return for Spouse 2’s estate, Spouse 1 
would receive approximately $9 Mil-
lion of Spouse 2’s unused exemption, 
potentially resulting in approximate-
ly $3.6 Million of estate tax savings 
under current law upon Spouse 1’s 
subsequent death. 

In drafting such provisions, care-
ful consideration should be given to 
whether the surviving spouse can 
cause the Personal Representative 
of the deceased spouse’s estate to 
make the portability election, as well 
as how the expense for making the 
portability election will be allocated. 
Consider the following language:

Sample Language 5: Use of Deceased 
Spousal Unused Exclusion Amount. 
The parties acknowledge that the 
Internal Revenue Code currently 
provides the opportunity for the 
deceased spousal unused exclusion 
amount (as defined in I.R.C. 
§ 2010(c)(4)) (the “DSUE amount”) 
to be transferred to the surviving 
spouse for estate and gift tax 
purposes (the “Portability Election”) 
pursuant to an election to be made 
following the death of a spouse. 
The parties further acknowledge 
that, in order to make the 
Portability Election, the executor 
of a deceased spouse’s estate is 
currently required to file a Federal 
estate tax return showing the 
computation of the DSUE amount, 
within nine (9) months following 
the deceased spouse’s death plus 
any filing extensions approved 
by the Internal Revenue Service. 
[Spouse 1] and [Spouse 2] agree 
that the survivor of them shall be 
entitled to have the benefit of the 
deceased spouse’s DSUE amount to 
the greatest extent permitted under 
applicable Federal law. Each party 
hereby agrees to direct the executor 
of his or her estate in his or her last 
will and testament or in any other 
testamentary instrument to do all 
things necessary to make a valid 
Portability Election, if requested 
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by the surviving party to do so, to 
transfer his or her DSUE amount 
to the other. The party receiving 
the benefit of the DSUE amount 
shall reimburse the estate of the 
deceased party for all reasonable 
costs incurred by the deceased 
party’s executor in the preparation 
and filing of any documentation 
necessary to make the Portability 
Election, including an estate tax 
return. The parties acknowledge 
that the DSUE amount of either 
spouse cannot be determined until 
the death of such spouse and that 
each party may make gifts during 
his or her lifetime or otherwise 
dispose of his or her property 
at death in accordance with the 
terms of this Agreement which 
would reduce or even eliminate 
the DSUE amount of a deceased 
spouse. Nothing contained in this 
paragraph shall be construed to 
limit the ability of either spouse to 
dispose of his or her assets, either 
during life or at death.

The sample language above pro-
vides that the surviving spouse may 
cause the deceased spouse’s Personal 
Representative to file an estate tax 
return in order to make the portabil-
ity election so that the decedent’s un-
used exemption amount may become 
available to the surviving spouse. The 
sample language also provides that 
the surviving spouse will reimburse 
the deceased spouse’s estate for the 
expenses incurred in preparing and 
filing the estate tax return for porta-
bility purposes.

Conclusion
There are numerous potential tax 

benefits available to married persons 
which should be considered by attor-
neys in drafting or advising with re-
spect to marital agreements. Failure 
to consider such benefits may result 
in the loss of substantial tax savings 
otherwise available to one or both 
spouses. 

Miranda M. Weiss is an associate 
and Alfred J. Stashis, Jr. is a share-
holder of Dunwody White & Landon, 
P.A. in Naples, FL. Mr. Stashis is 

board certified in wills, trusts and 
estates.

Endnotes
1 All Sample Language provisions in this 
Article are intended for educational purposes 
only. The language should be vetted carefully 
and tailored to meet each individual client’s 
needs. 
2 26 U.S.C. § 2523. Assuming both spouses 
are U.S. citizens during the taxable year. Gifts 
to a spouse who is not a U.S. citizen are gov-
erned by § 2523(i) and beyond the scope of this 
Article. 
3 26 U.S.C. § 2503(b). 
4 26 U.S.C. § 2513. 
5 This example assumes the gifts to grand-
children are made outright or in § 2642(c) 
trusts. 
6 As of January 1, 2018, the lifetime gift and 
estate tax exclusion has increased to $11.18 
Million per taxpayer, or $22.36 Million for a 
married couple, less prior lifetime taxable gifts, 
and assuming each spouse is a U.S. citizen. 
7 GST tax refers to Chapter 13 of the Internal 
Revenue Code, which imposes a tax on the 
transfer to or for the benefit of persons who 
are two or more generations younger than the 
donor (i.e., a transfer from a grandparent to a 
grandchild). 
8 26 U.S.C. § 1041(a)(2). Section 1041(c) de-
fines a transfer of property as “incident to 
divorce” if (i) such transfer occurs within 1 
year after the date the marriage ceases or (ii) 
is related to the cessation of the marriage. 
9 26 U.S.C. § 2516. The Internal Revenue 
Code provides transfers of property from an 
individual to a spouse or former spouse in 
settlement of his or her marital or property 
rights or to provide a reasonable allowance for 
the support of a minor is not treated as a gift 
where transfers are made pursuant to a settle-
ment agreement and a divorce occurs within 
the 3-year period beginning on the date that 
is 1 year before such agreement is entered into 
regardless if the agreement is approved by a 
divorce decree. 
10 26 U.S.C. § 215(a) (permitting the deduc-
tion of alimony payments); 26 U.S.C. § 71 (a) 
(requiring the inclusion of alimony in gross 
income). 
11 See Publication 504 (2017), Internal Rev-
enue Service, available at https://www.irs.gov/
pub/irs-pdf/p504.pdf. 
12 § 11051 H.R.1 Public Law No. 115-97, 115th 
Congress (2017-2018). 
13 Duffey and Koren, “Personal Planning 
Under the Tax Cuts and Jobs Act—Part Two” 
at Page 11, Florida Bar Tax Section CLE, May 
23, 2018.
14 26 U.S.C. § 2056. QTIP is defined in § 
2056(b)(7)(B) as property passing from the 
decedent to the surviving spouse in which the 
surviving spouse is entitled to all the income 
from the property at least annually and is the 
only permissible recipient of income or prin-
cipal during surviving spouse’s lifetime. The 
property qualifies for the marital deduction if 
the QTIP election is made, and the property is 

included in the surviving spouse’s gross estate 
for federal estate tax purposes upon the subse-
quent death of the surviving spouse. 
15 26 U.S.C. § 2510(c)(2)(B) allowing for the 
surviving spouse to increase his or her appli-
cable exclusion amount by the amount of the 
deceased spouse’s unused exclusion. 
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Benefits of Being a Member of 
The Florida Bar Family Section

Mary Elias, CMA, CDFA, CFE
West Palm Beach

I am a non-attorney, affiliate mem-
ber of the Family Law Section of 
The Florida Bar. I joined the Family 
Law Section because of my forensic 
accounting and fraud experience in 
family law matters. I find that being 
an affiliate member offers benefits 
and opportunities in my professional 
practice. Those benefits and oppor-

tunities include:

	Networking with attorneys who practice exten-
sively in marital and family law.

	Networking with other affiliate members of the 
Family Law Section.

	Involvement in committees, such as Support Is-
sues, Equitable Distribution, Litigation Support 
and Children’s Issues.

	Attending continuing education courses at dis-
counted member rates.

	Receiving the Family Law Section’s quarterly 
publication of The Commentator.

	Receiving the Family Law Section’s monthly 
FAMSEG e-Newsletter.

As an affiliate member, I have taken advantage of 
the numerous opportunities to network with attor-
neys and other professionals who practice marital 
and family law. The section has numerous events 
throughout the year that include the Marital and 
Family Law Certification Review Course, Section 
committee meetings and in-state and out-of-state 
retreats. Most events include a Mix & Mingle or recep-
tion that allows for those in attendance to socialize 
on more informal basis.

Over the last five years, I have participated in vari-
ous Family Law Section committees. The list of the 
various committees is found on the Family Law Sec-
tion website. Members can choose from the Substan-
tive Law Committees or the Operational Committees. 
This is a great opportunity to learn first-hand what 
is being proposed to the legislature before it becomes 
law and perhaps even provide valuable input. There 
is no cost to attend the committee meetings and an 
added benefit is the reception at the end of the day!

The Family Law Section offers numerous continu-
ing education opportunities where you can earn CPE 
credits for your professional designation require-
ments. Additionally, there is a reduced charge to at-
tend as a member of the section and great topics to 
pick from.

The section has two publications that members 
receive. The Commentator Magazine is published 
quarterly. Articles relevant to the section are always 
welcome from other professionals. The second publica-
tion is a monthly e-Newsletter called FAMSEG. This 
newsletter is where you will find all the upcoming 
events, EC Member Spotlights, awards, announce-
ments, pictures from section events, and much, much 
more. This is a great way to get yourself known as a 
supporter of the Family Law Section of The Florida 
Bar. 

Mary Elias, CMA, CDFA, CFE is the Director of Fo-
rensic Accounting at Divine Blalock Martin Sellari in 
West Palm Beach, Florida.  Ms. Elias is a Certified Di-
vorce Financial Analyst, a Certified Fraud Examiner, 
and a Chartered Professional Accountant-Certified 
Management Accountant.

MARY ELIAS
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DID YOU KNOW? 
Non-Attorneys Can Become Affiliate 

Members of the Family Law Section of 
the Florida Bar! 

Benefits of becoming a member: 
• Attend and participate in live meetings concerning cutting edge Marital & Family 

Law issues.   

• Network with Family Law attorneys, judiciary, and members from across the State 

of Florida at meetings and social events. 

• Receive a discount for Family Law Section CLEs, including the Marital & Family Law 

Review Course. 

• Receive the Family Law Section’s Commentator, a quarterly publication containing 

all of the latest news involving the Family Law Section and Florida family lawyers.  

• Receive the Family Law Section’s e-Newsletter, FAMSEG. 

• You can even publish articles concerning your field in the Commentator and 

FAMSEG. 

• Receive recognition for your credibility and dedication to the area of Marital & 

Family Law.   

Affiliate members consist of: 
Mental Health Professionals 

Vocational Experts 

Parenting Coordinators 

Social Investigators 

Mediators 

CPAs & Forensic Accountants 

Collaborative Professionals 

FL Law School Students & 

Professors 

Guardian Ad Litems      

Business Evaluators 

Paralegals 

Expert Witnesses 

Appraisers 

Actuaries

Please visit the Family Law Section of the Florida Bar website to register as 
a member at familylawfla.org.  Membership is only $65.00. 
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Be a Hero Today: Two Secrets to Get 
Green Cards for Your Clients

By Elizabeth R. Blandon, Esq.
Weston, Florida

Arrests of un-
documented per-
sons have risen 
over fifty percent 
compared to this 
same time in 2016. 
The fear is palpa-
ble. The dream of 
many foreigners 
– especially those 

who may have entered without autho-
rization years ago but now have lives 
here – is legal permanent residency. 
This status allows them to live and 
work in the United States perma-
nently. Persons who have this status 
receive green cards. (Yes, literally, 
they are green.) 

In family court proceedings, having 
a green card makes for a stronger 
argument that the foreigner will be 
able to remain in the United States. 

Foreigners can obtain green cards 
even if immigration judges have or-
dered them deported. Ex-spouses of 
residents and U.S. citizens who have 
been psychologically mistreated 
can receive green cards even if they 
are no longer married to the abusers. 
This article briefly summarizes both 
of these laws, which – when used by 
an experienced immigration lawyer – 
will make you a hero to your clients.

Provisional Waiver Even 
with a Deportation Order

The Provisional Waiver is currently 
one of the few ways to obtain legal 
permanent residency by “forgiving” 
ONE unauthorized entry into the 
United States. Importantly, your cli-
ent can only have entered the United 
States ONCE without authorization 
after 1997.

If your client has a U.S. citizen or 
legal permanent resident spouse or 

parent, the following persons – re-
gardless of whether they entered 
without authorization or have an 
order of deportation or removal (so 
long as it has not been reinstated) – 
can get green cards:
• Spouses and Parents of U.S. Citi-
zens
• Children of U.S. Citizens (Whether 
Married or Not, Regardless of Age)
• Spouses of Permanent Residents
• Unmarried Children of Permanent 
Residents (Regardless of Age)
• Brothers and Sisters of Adult U.S. 
Citizens

If your client does not have a U.S. 
citizen or legal resident spouse or 
parent, she may still be able to get a 
green card with a U.S. citizen sibling 
who is older than 21 years of age. 
The U.S. citizen sibling can apply for 
their parent to BECOME a legal per-
manent resident. Thus, the foreign 
sibling will have an LPR parent and 
will qualify for this program; the for-
eign parent will have an LPR Spouse 
and will qualify.

The process involves the immigra-
tion lawyer working with both U.S. 
Citizenship and Immigration Service 
and Department of State. If the client 
has a deportation order, additional 
work will also be required with the 
Immigration Court system. Never-
theless, this path ends with one very 
grateful client, who can finally be 
counted in a country where they may 
have spent decades.

VAWA Based on “Common” 
Mental Cruelty

Another law that allows foreigners 
to obtain legal permanent residency 
despite an illegal entry and despite 
having a deportation order is the 
Violence Against Women Act. This 

ELIZABETH BLANDON

law is falsely named: Violence is not 
required, and it also applies to men! 
Fortunately, the law protects foreign-
ers who have survived physical abuse 
OR extreme mental cruelty by a U.S. 
citizen or legal permanent resident 
spouse.

Because we represent VAWA cli-
ents who have never been physically 
hurt at all, hospitalization records 
are not required. Police reports are 
not required. We demonstrate the 
harm using client and witness state-
ments, which we edit meticulously 
(for grammar, spelling and clarity) 
to ensure that they convey the horror 
endured.

The standard to demonstrate ex-
treme mental cruelty in immigration 
is much lower than demonstrating 
abuse in a family law court. In fact, 
we have won cases based on what 
is sadly considered commonplace in 
some homes: coercion and threats, 
intimidation, ridiculing, isolation, 
denying and blaming, economic abuse 
and demanding sexual favors. 

By letting your clients know about 
the Provisional Waiver and VAWA 
options, you become an ambassador 
of opportunity. You will be the one 
they remember as the person who put 
them on a path to a work permit and 
eventually U.S. citizenship.

 
Elizabeth R. Blandon, Esq., is Chair-
person of the Nationality & Immigration 
Board Certification Committee. Board 
certification is the highest lawyer rat-
ing in ethics and ability by the Florida 
Bar. Her book “Top NINE Immigration 
Must-Knows for Family Law Attorneys” 
is available free of charge by emailing 
ERBlandon@blandon-law.com. Her 
ebook about VAWA benefits is also avail-
able online at www.Blandon-Law.com.
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